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Abstract

Recent progress in GUI agents has substantially
improved visual grounding, yet robust planning
remains challenging, particularly when the envi-
ronment deviates from a canonical initial state.
In real applications, users often invoke assis-
tance mid-workflow, where software may be par-
tially configured, steps may have been executed
in different orders, or the interface may differ
from its default setup. Such task-state variabil-
ity is pervasive but insufficiently evaluated in ex-
isting GUI benchmarks. To address this gap,
we introduce WorldGUI, a benchmark cover-
ing ten widely used desktop and web applica-
tions with tasks instantiated under diverse, sys-
tematically constructed initial states. These vari-
ations capture realistic human—computer interac-
tion settings and enable diagnostic evaluation of
an agent’s ability to recover, adapt plans, and
handle non-default contexts. We further present
WorldGUI-Agent, a simple and model-agnostic
framework that organizes planning and execu-
tion around three critique stages, improving re-
liability in dynamic environments. Experiments
demonstrate that state-of-the-art GUI agents ex-
hibit substantial performance degradation under
non-default initial conditions, revealing limited
robustness and fragile planning behaviors. Our
benchmark and framework provide a founda-
tion for developing more adaptable and reliable
GUI agents. The code and data are available at
https://github.com/showlab/WorldGUI.

1. Introduction

2. Introduction

Graphical User Interface (GUI) automation has emerged
as a promising direction for productivity-oriented Al sys-
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tems. With the rapid advancement of Multimodal Large
Language Models (MLLMs) such as GPT-5 (Singh et al.,
2025) and Claude-4-Sonnet (Anthropic, 2025), GUI agents
have demonstrated the potential to assist users in software
usage, file management, office design, coding, and web
browsing, reducing repetitive work and improving workflow
efficiency.

Unlike traditional computer vision tasks such as image
recognition (He et al., 2016) or visual question answer-
ing (Antol et al., 2015; Goyal et al., 2017), GUI automation
operates in a highly dynamic environment where the inter-
face state evolves as a result of user actions, system configu-
rations, or partial task progress. However, existing online
GUI benchmarks, including WebArena (Zhou et al.), Web-
Voyager (He et al., 2024), OSWorld (Xie et al., 2024), Assist-
GUI (Gao et al., 2024), and WindowsAgentArena (Bonatti
et al., 2024), primarily evaluate agents from a single, canon-
ical initial state and measure success only at the end of the
trajectory. Such static evaluation overlooks several common
situations in real-world usage: (1) software interfaces are
often not in their default configurations, (2) users frequently
request assistance from intermediate states of partially com-
pleted tasks, and (3) agents with the same low success rate
(e.g., 20%) may differ substantially in their robustness, plan-
ning stability, and self-correction behavior differences that
cannot be revealed under a single start-state protocol.

In parallel, robustness-oriented GUI benchmarks such as
GUI-Robust (Yang et al., 2025) examine how agents respond
to interface-level perturbations, including layout shifts, ap-
pearance variations, and transient pop-ups. These bench-
marks vary the visual presentation while keeping the task
goal and initial state fixed, providing valuable insights into
perception robustness. In contrast, WorldGUI does not
alter UI skin, resolution, or layout; instead, it targets fask-
progress—level variation by modifying the executed steps
themselves (Add-, Trim-, and Adjust-step). This form of
task-state variability, such as missing, redundant, or re-
ordered steps, poses challenges fundamentally different
from interface perturbations, making the two robustness
dimensions complementary and largely orthogonal.

To complement existing benchmarks, we focus on ro-
bustness to intermediate starting states, a ubiquitous but
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Table 1. Comparison with other online GUI benchmarks. WorldGUI is a unique benchmark that embraces diverse initial states and
better reflects the authentic interactions in GUI scenarios. Env?: Indicates whether an environment is required to be deployed.

Benchmark Software Task  Platform  Env? Inst. Video? GT Plan L&k State
variability?
WebArena (Zhou et al.) 6 812 Web Yes X X X
VisualWebArena (Koh et al., 2024) 3 910 Web Yes X X X
WebVoyager (He et al., 2024) 15 643 Web Yes X X X
AutoDroid (Wen et al., 2024) 13 158 Android OS  Yes X X X
AndroidWorld (Rawles et al., 2024) 20 116 Android OS Yes X X X
AgentStudio (Zheng et al., 2025) 9 205 Desktop + Web Yes X X X
Mobile-Eval (Wang et al., 2024) 10 30 Android OS  Yes X X X
APPAgent (Zhang et al., 2023) 10 50  Android OS Yes X X X
OSWorld (Xie et al., 2024) 10 369 Desktop Yes X X X
AssistGUI (Gao et al., 2024) 9 100 Windows No v X X
WindowAgentArena (Bonatti et al., 2024) 11 154 Windows Yes X X X
WorldGUI 10 611 Win. + Web No v v v

under-explored aspect of GUI interactions. We introduce
WorldGUI, a benchmark that systematically constructs di-
verse initial states for each task by applying controlled pre-
actions. These pre-actions modify task progress itself (e.g.,
steps partially completed, over-executed, or executed in a
different order), allowing tasks with the same goal to be-
gin from multiple realistic contexts. This design mirrors
how real users summon assistance in the middle of work-
flows and enables diagnostic evaluation of an agent’s ability
to recover, adapt plans, and handle contextual variability.
WorldGUI covers 10 widely used desktop applications and
provides 611 tasks, each paired with a user query, instruc-
tional video, and project file. To construct meaningful state
variations, trained annotators first demonstrate ground-truth
(GT) plans, after which we generate augmented initial states
via pre-actions.

In addition, we propose WorldGUI-Agent, a simple and
general GUI agent framework grounded in critical-thinking
principles, an aspect that has received relatively limited
attention in prior GUI agents (Hong et al., 2024; Cheng et al.,
2024; Lai et al., 2024; Agashe et al., 2025a; Wu et al., 2024).
Dynamic GUI environments often deviate from expected
states due to user behavior or system configurations, making
it essential for agents to detect mismatches and adapt their
plans. Through an analysis of real-world GUI scenarios, we
distill three design principles that we argue are fundamental
for GUI automation: (1) Post-Planning Critique, (2) Pre-
Action Validation, and (3) Post-Action Evaluation. These
components enable WorldGUI-Agent to refine plans, verify
step prerequisites, and evaluate action outcomes, thereby
improving reliability in dynamic settings.

Experiments reveal three key observations: (1) a substantial
gap remains between humans and current agents, with mod-
els such as UI-Tars and GPT-5.1 still struggling on our cu-
rated desktop GUI tasks; (2) performance degrades sharply
under non-default initial states, highlighting limited robust-
ness and fragile planning capabilities; and (3) WorldGUI-
Agent significantly improves robustness and overall task

success across WorldGUI and WindowsAgentArena, even
when built upon weaker base models and without prompt
tuning, demonstrating the importance of multi-level critique
for dynamic GUI automation (see Section 6).

3. Related Work
3.1. GUI Benchmarks

GUI benchmarks provide the foundation for evaluating
computer-use agents across web, desktop, and mobile en-
vironments. Early interactive benchmarks such as Web-
Shop (Yao et al., 2022), WebArena (Zhou et al.), and We-
bVoyager (He et al., 2024) center on browser tasks with
long-horizon goals. OSWorld (Xie et al., 2024) and mobile
benchmarks, including MobileAgent (Wang et al., 2024)
and AppAgent (Zhang et al., 2023) broaden coverage to
multi-application desktop and mobile ecosystems. Assist-
GUI (Gao et al., 2024) and WindowsAgentArena (Bon-
atti et al., 2024) provide online execution environments for
Windows-based tasks.

Recent benchmarks emphasize scalability and online evalu-
ation. UIExplorer (Nica et al., 2025) offers a large-scale en-
vironment for GUI exploration in both structured-DOM and
pure screen modes. GUI-World (Chen et al., 2025) provides
multi-application desktop tasks with online execution and
standardized initial states. Robustness-oriented suites such
as GUI-Robust (Yang et al., 2025) examine agents under
interface-level perturbations (e.g., layout shifts, visual noise,
pop-ups), focusing on perception and action robustness.
While these benchmarks significantly advance GUI automa-
tion, they overwhelmingly assume a single canonical initial
state for each task. They do not explicitly evaluate rask-state
variability, such as partially completed workflows, missing
or redundant steps, or alternative intermediate contexts com-
mon in real user workflows. Our benchmark, WorldGUI,
complements existing online environments by systemati-
cally constructing diverse initial states for the same task
goal via controlled pre-actions, enabling diagnostic evalua-
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Figure 1. WorldGUI. Left: WorldGUI creates pre-actions for each meta task, leading to different initial states. It successfully reflects the
real-world human-computer interaction process. Right: components in WorldGUL

tion of robustness, recoverability, and planning stability in
dynamic GUI environments.

3.2. GUI Agents

Recent progress in GUI agents spans perception, ground-
ing, planning, and full computer-use control. CogA-
gent (Hong et al., 2024) improves GUI perception, while
SeeClick (Cheng et al., 2024) and SeeAct (Zheng et al.,
2024) focus on grounding UI elements for more reliable
action prediction. MobileAgent (Wang et al., 2024) and
AppAgent (Zhang et al., 2023) extend these capabilities
to mobile environments. On desktop and OS-level tasks,
AssistGUI (Gao et al., 2024) adopts a Plan-Act pipeline
with a single post-action checker. Agent-S (Agashe et al.,
2025a) introduces experience-augmented hierarchical plan-
ning with a Manager-Worker architecture, a self-evaluator,
and an Agent-Computer Interface (ACI). Agent-S2 (Agashe
et al.,, 2025b) further incorporates specialist grounding
(Mixture-of-Grounding) and Proactive Hierarchical Plan-
ning, achieving strong performance across OSWorld, Win-
dowsAgentArena, and AndroidWorld. Beyond inference-
time frameworks, several works train GUI agents or their
components. Aguvis (Xu et al., 2024) and UGround (Gou
et al., 2025) train pure-vision or universal grounding models
at scale. AgentTrek (Xu et al., 2025) synthesizes multi-step
trajectories from web tutorials for supervised training, and
SE-GUI (Yuan et al., 2025) applies reinforcement learning
to strengthen grounding robustness. While these approaches
enhance perception, grounding, or hierarchical planning,
they typically employ only a single verification stage (e.g.,
self-evaluation or post-action checking). In contrast, our
framework WorldGUI-Agent focuses on structuring the
verification process itself for dynamic GUI environments.
WorldGUI-Agent introduces three complementary critique
stages: Post-Planning Critique, Pre-Action Validation,
and Post-Action Evaluation, enabling agents to detect state
mismatches, assess step readiness, and repair execution
failures. This multi-level critique design is orthogonal to
hierarchical planners and training-based pipelines, and can
be combined with them without additional model training.
A component-wise comparison is provided in Table 3.

4. WorldGUI Benchmark

Following prior work (Xie et al., 2024; Zhou et al.), we
model GUI automation as a partially observable Markov
decision process (POMDP). A complete specification of
the POMDP components and the execution environment is
provided in Appendix A.

4.1. Data Source

WorldGUI consists of a broad spectrum of widely-used desk-
top applications, which can be categorized into five main
groups: (i) Office, includes PowerPoint, Word, Excel, and
Adobe Acrobat; (ii) Windows Usage, includes System Set-
tings and File Management; (iii) Web Usage, includes the
configuration of Youtube and website operations; (iv) Cod-
ing, focus on the customization, configuration and editing
of Visual Studio Code (VSCode); (v) Media, operating VLC
player for video editing and creation.

4.2. Pipeline of Data Construction

We engaged four annotators and developed the necessary
scripts to structure and format the data. To reduce annotator-
style variance, all annotators followed a standardized anno-
tation protocol. Additionally, to facilitate ground truth (GT)
plan generation and pre-action generation, we implemented
simple agent-based methods to collect the relevant data. The
overall data construction pipeline comprises six steps, as
detailed below.

Raw Video Collection. We collect raw videos from the
YouTube website as there are a lot of high-quality tutorials
for desktop applications with high views. For each software,
we ask the annotators to watch the videos first and download
them via the diversity of software usage.

Instruction Video Preparation. After obtaining the raw
videos, we write the script codes to cut the lengthy and
noisy videos into the sub-clips (30 seconds to 3 minutes)
that serve as the instructional video.

User Query Generation. After obtaining the instructional
videos, annotators are asked to manually write user queries
corresponding to each video. For example, a user query for
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Table 2. Task category, task activities, and project file of the desktop applications in WorldGUI.

Category Applications All Task  Avg. Length  Task Activities Project File Type
Office PowerPoint 64 7.1 Change the content style and layout; Design new effects project.pptx
Office Word 63 4.1 Formatting the content style and layout project.docx
Office Excel 70 5.1 Table formatting; Data management and processing project.xlsx
Office Adobe Acrobat 66 5.1 Automatic add electric signature; Document management  project.pdf
Coding VSCode 56 4.4 Code editing; Software configuration vscode.exe
Windows Usage  Settings 69 7.1 Advanced personalized and safety settings; ms-Settings
Windows Usage  File Explorer 44 5.1 File management: Add, delete, rename, and move files explorer.exe
‘Web Usage ‘Web Browser 59 7.8 ‘Web operation web browser + URL
Web Usage Youtube (Online) 61 4.8 Video and account configurations web browser + URL
Media VLC Player 59 10.8 Video editing and creation project.mp4
Total (Average) — 611 6.0
Average Meta-Task Length per Software
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Figure 2. The left shows software taxonomy in WorldGUI. The right shows the distribution of task length.

a task involving File Explorer might be: “Please compress
the project.mp4 into an MPEG-4 file optimized in 1080p.”

Project File Preparation. Following the AssistGUI (Gao
et al., 2024), we create the project file for each task to ensure
reproducibility without relying on resource-intensive virtual
machines (Xie et al., 2024) or Docker environments (Bonatti
et al., 2024). This approach guarantees that the testing
process begins from a consistent state. When combined
with pre-actions, it enables augmentation of the same task
with various initial states.

GT Plan Generation. Given a user query ¢ and instruc-
tional video v, we automatically generate an initial draft
plan using a GPT-4o0-based agent. Annotators then watch
the video and execute the task while reviewing the draft
plan, correcting any inaccurate or missing steps to obtain
the final GT plan. GT plans are used solely for construct-
ing pre-actions and are never provided to or used by any
evaluated agent.

Pre-Actions Generation. To vary the task, we propose
introducing pre-actions before the task begins. These pre-
actions are created by annotators and involve correspond-
ing scripts and agents. They are written in Python code,
for example: from pyautogui import click,
rightClick\n rightClick (800,400). The pre-
actions primarily serve two purposes: 1) Simulating In-
termediate Task States: Pre-actions can complete specific
steps of a task, creating a starting point from an intermedi-
ate state. This approach addresses scenarios where users

may invoke GUI assistant at any time. For example, if the
task involves opening a dropdown menu, the pre-action may
pre-open the menu. If the agent fails to recognize this pre-
condition and follows its plan to click the menu again, it
might inadvertently close the menu, causing task failure. 2)
Introducing Diverse Initial Context States: Pre-actions
can also introduce variations in the initial state, such as
opening random tabs or settings. This ensures that the start-
ing state is unconventional, challenging the agent to adapt
by modifying its plan or adding necessary new steps. See
example in Figure 5. Each pre-action was manually verified
to ensure the task remained solvable.

4.3. Data Statistics

Overall. We present the detailed task taxonomy and lengths
about WorldGUI in Figure 2 and Table 2. A total of 111
meta tasks were collected from these applications, with
each task being augmented 5 times based on the task’s
functionality, resulting in 500 augmented tasks. In total,
WorldGUI comprises 611 tasks, and every task has almost 6
variation instances, which is capable of reflecting the real-
world interactions of the GUI environment. All data are
available for reference.'

Augmentation tasks type analysis. As we summarize, the
real GUI scenarios include: (1) The software interface is not
in its default state. (2) The human-computer interactions

'nttps://huggingface.co/datasets/
anonymousABC/WorldGUI-Bench
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Figure 4. The distribution of different task difficulty.

may start from the intermediate state of a specific task. Our
augmentations lie in two main groups: (1) simulating the
intermediate states and (2) introducing diverse initial states.
We divide the two groups into three types: Add-step, Trim-
step, and Adjust-step. For Add-step, it represents various
unrelated state augmentations to simulate the scenario that
we may start the task in another unrelated task or interfaces,
the agent should replan the task to add necessary steps. For
Trim-step, it represents that we finish several steps of a
long task and make the task in an intermediate state. For
Adjust-step, it is usually a small modification of the existing
state, such as changing the interface by clicking another Tab
or clicking a button to open an unrelated dropdown menu.
Most of the time, it would not require new steps to return to
the target task procedure. This augmentation may mislead
the agent in state understanding, making them jump or miss
the key steps. As shown in Figure 3, the manually created
augmentations mainly belong to the add-step. Adjust-step
could be the second-largest part. Due to the low complexity
of the interfaces of File Explorer, we cannot create many
augmentations for adjust-step.

Task difficulty analysis. Figure 4 shows the distribution of
the task difficulty across desktop applications. We annotated
the task difficulty level based the subjective software usage
experience. The results indicate that the tasks in Adobe
Acrobat and VLC player are more challenging. The tasks
in Excel, PowerPoint, and Word are more at the medium
and simple levels. By considering the Success Rate and task
length on these tasks, one can know that the tasks are easy
for humans, but hard for current GUI agents. Overall, the

a User Query “Set the document to Two Page View from the View menu.”

E GT Plans

e display to two-page
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Figure 5. An example of augmenting one GUI task with manually
aug the initial state and then using the execution scripts and corre-
sponding agents to obtain the pre-action for each augmented case.
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task difficulty of our created data is diverse across different
applications.

5. WorldGUI-Agent

Table 3. Comparison with closely related GUI agents.

Method Post-Plan  Pre-Action Post-Action
Mobile-Agent / V2 X X 4
AssistGUI X X v
Agent-S/S2 X X v
Mobile-Agent-E X X v
WorldGUI-Agent (ours) v v v

To study robustness under the dynamically perturbed initial
states of WorldGUI, we adopt a lightweight, non-training
agent framework. As summarized in Table 3, most exist-
ing agents rely on a single post-action evaluation module.
Rather than proposing a new algorithm, our aim is simply to
structure the standard perception—planning—execution loop
into clearer verification stages.WorldGUI-Agent introduces
three small modules at different abstraction levels: Planner-
Critic refines the draft plan; Step-Check uses the screen-
shot and metadata to decide whether a plan step should
be executed, skipped, or rewritten; Actor-Critic validates
each action using the current observation and recent action
history. Compared to prior self-reflection approaches (e.g.,
Reflexion, CRITIC), which apply a single global critique,
our checks are lightweight and distributed across plan, step,
and action levels to better handle task-progress variation.
Full module specifications and I/O formats are included in
Appendix B.

6. Experimental Results

Implementation Details. We use PyAutoGUI? to extract
basic metadata from GUI screenshots, including bounding
boxes of buttons, icons, and text regions. We then imple-

2https ://pyautogui.readthedocs.io
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Table 4. Success rate (%) of different agents on WorldGUI. Human* denotes the average performance of four expert participants who have
watched the instructional video only once, similar to the model. Meta represents the meta task, while Aug. represents the augmented task.

Office Win. Usage Web Coding Media

Method O 11

etho Meta Aug. ‘ Meta  Aug. ‘ Meta Aug. ‘ Meta  Aug. ‘ Meta  Aug. vera
Plan-Act w/ Gemini-2.0 8.9 3.2 8.3 34 | 286 162 | 182 22 | 100 20 6.9
Plan-Act w/ GPT-40 133 10.1 8.3 23 23.8 11.1 9.1 22 10.0 2.0 8.5
AssistGUI w/ GPT-40 267 161 | 292 79 | 333 202 | 273 1L.1 | 100 82 16.5
CCU w/ Claude-3.5-Sonnet | 28.9 193 | 29.2 146 | 714 323 | 546 222 | 300 6.1 23.6
UI-TARS-1.5 289 161 | 125 22 | 286 9.1 | 367 6.7 0.0 0.0 12.3
Agent S2 333 165 | 70.8 59.6 | 524 455 | 455 37.8 | 200 163 342

WorldGUI-Agent (Ours)

w / Gemini-2.0 31.1  17.0 | 20.8 9.0 38.1 293 | 364 11.1 | 200 10.2 19.1
w/ GPT-40 422 243 | 417 112 | 47.6 354 | 455 156 | 40.0 122 26.0
w / Claude-3.5-Sonnet 57.8 326 | 50.0 19.1 | 762 465 | 546 26.7 | 50.0 184 36.0
w/GPT-5.1 644 37.6 | 625 404 | 857 53.5 | 63.6 46.6 | 60.0 26.5 45.8
Human* | 889 835 | 1000 89.9 | 952 808 | 81.8 778 | 90.0 857 | 853

Table 5. Success rate (%) of our WorldGUI-Agent (w/ GPT-40) with the ablation of different critical modules.

Office ‘Win. Usage

Web Coding Media

Method Meta Aug. | Meta Aug. | Meta Aug. | Meta Aug. | Meta Aug Overall
Full Model 422 243 417 112 | 47.6 354 | 455 156 | 400 122 26.0
— w/o Planner-Critic | 31.1  17.0 | 20.8 9.0 38.1 253 | 364 11.1 | 200 10.2 18.5
— w/o Step-Check 31.1  19.3 | 20.8 9.0 333 283 | 455 133 | 20.0 8.2 19.8
— w/o Actor-Critic 156 7.8 42 3.4 286 172 | 0.0 8.9 100 6.1 9.7

Table 6. Success rate (%) of our WorldGUI-Agent with the ablation
of Instructional Video.

Method | PPT Word Excel Acrobat VSCode | Overall
Full Model 45.5 36.4 50.0 36.4 45.5 429
w/o Inst. Video | 45.5 273 253 18.2 273 ‘ 28.6

Table 7. Running time comparison.

Method Executed Steps  Time (seconds)
Agent-S 10 131.98
Agent-S2 9 108.65
WorldGUI-Agent 24 129.55

ment software-specific GUI parsers® that further refine el-
ement grounding by incorporating OCR results obtained
through the Google OCR API. Details of our baseline agent
WorldGUI-Agent are provided in Appendix B. All experi-
ments are conducted under a fixed screenshot resolution of
1920x 1080 and a display scale of 125%. For WorldGUI-
Agent, we limit the Actor—Critic correction attempts to three
steps to control interaction cost. The total number of tri-
als allowed per task is set to 4N + 1, where N is chosen
empirically based on the task category.

Evaluation. Given that our WorldGUI includes 611 GUI
tasks, we engaged four participants with strong coding and
software backgrounds to test all tasks and document their
evaluation results. Metric. Following the previous works,
we use Success Rate (SR) as the metric.

Baselines. We implement the baseline approach called Plan-
Act with different MLLMs as the base model. It focuses
on investigating the basic capabilities of task planning and

*https://anonymous.4open.science/r/
WorldGUI-7A5C/agent/gui_parser/

Table 8. Task counts and success rates (SR, %) across different
augmentation types for WorldGUI-Agent (GPT-5.1).

Augmentation Type #Tasks SR (%) #Success
Add-step 255 34.1 87
Trim-step 119 52.1 62
Adjust-step 130 43.1 56
Total 500 41.0 205

action prediction. Additionally, we compare our WorldGUI-
Agent with two agentic frameworks and two SOTA GUI
models: AssistGUI (Gao et al., 2024), Agent-S2 (Agashe
et al., 2025b), Computer Use (Claud-3.5-Sonnet) (An-
thropic, 2024), and UI-TARS-1.5 (Qin et al., 2025). Assist-
GUI and Agent-S2 are two prominent agentic frameworks
designed for Desktop GUI Automation, which can plan the
task and then execute the task step by step by following the
query. We increase the base model to GPT-40 for Assist-
GUI and Claude-Sonnet-4 of Agent-S2 for fair performance.
Claude Computer Use (CCU) is the leading proprietary
model specially designed for computer use. We use the
open-source implementation OOTB (Hu et al., 2024) as the
codebase and then add the subtitle of instructional videos
into the input prompt for a fair comparison. We also imple-
ment our WorldGUI-Agent with four different MLLMs to
illustrate the effectiveness of our proposed universal agent
framework.

6.1. Main Results on WorldGUI

Overall. Table 4 reports the success rates (SR) of different
agents and human experts on our WorldGUI benchmark,
broken down by task type (Meta vs. Aug.) across five
categories: Office, Win. Usage, Web, Coding, and Media.
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From these results we draw the following main conclusions.

A large gap remains between agents and humans. The
best-performing agent (WorldGUI-Agent with GPT-5.1)
achieves an overall SR of only 45.8%, which is less than
half of the 85.3% attained by human experts. This stark
contrast underscores the difficulty of our tasks and the need
for further advances in desktop GUI automation.

Agents generalize poorly to augmented tasks. Across
all methods, performance on Augmentation tasks (which
introduce interface or context variations) is substantially
lower than on their corresponding Meta tasks. For example,
Claude-3.5-Sonnet in the Win. Usage category attains 50.0%
on Meta tasks but drops to just 19.1% on Aug. tasks. This
highlights the importance to evaluate the agents on various
initial conditions.

Desktop GUI tasks pose a greater challenge than web
tasks. Every agent scores higher on Web tasks than on desk-
top application tasks. WorldGUI-Agent with GPT-5.1, for
instance, jumps from 85.7% on Web Meta to only 62.5%
on Win. Usage Meta, and the gap widens on their Aug-
mentation counterparts. Thus, desktop GUI tasks remain
challenges than widely-studied web GUI tasks (Cheng et al.,
2024; He et al., 2024).

WorldGUI-Agent consistently outperforms a naive Plan-
Act counterpart. By incorporating our three critical mod-
ules into the planning and execution loop, WorldGUI-Agent
substantially improves success rates over the basic Plan-
Act counterpart. Relative to Plan-Act, WorldGUI-Agent
raises overall SR by +12.2% with Gemini-2.0, +17.5% with
GPT-40, and +12.4% with Claude-3.5-Sonnet, demonstrat-
ing the effectiveness of our critical modules proposed for
WorldGUI-Agent.

Specialized GUI models transfer poorly to WorldGUI.
Despite achieving strong results on several existing GUI
benchmarks, specialized models do not perform well in our
setting. For example, UI-TARS-1.5 attains only 12.3% over-
all SR on WorldGUI, which is notably lower than general-
purpose MLLMs when used within our framework (e.g.,
36.0% for WorldGUI-Agent with Claude-3.5-Sonnet and
45.8% with GPT-5.1), and even below the CCU baseline
built on Claude-3.5-Sonnet (23.6%). Similarly, Agent-S2
reaches 34.2% overall SR, still far from human performance
and trailing behind WorldGUI-Agent with GPT-5.1. These
results indicate that training pipelines and architectures
tuned for single-start or less diverse benchmarks do not auto-
matically transfer to the multi-start, dynamically perturbed
settings of WorldGUI. In our evaluation, specialized GUI
models exhibit strong grounding but substantially weaker
planning, which leads to low success rates even when pro-
vided with additional signals such as instructional-video
subtitles.

6.2. Ablation Study

Impact of different critical modules. Table 5 reports an
ablation study of WorldGUI-Agent across five application
categories. The full model achieves an overall success rate
(SR) of 26.0%. Removing any core component leads to
notable degradation. Excluding the Planner-Critic reduces
SR to 18.5% (-7.5%), highlighting its role in plan refine-
ment. Removing Step-Check lowers SR to 19.8% (-6.2%),
mainly affecting multi-step interaction scenarios, suggest-
ing its effectiveness in intermediate error correction. The
most severe impact comes from removing the Actor-Critic,
which collapses SR to 9.7% (—16.3%), nearly eliminating
performance on Coding and Win. Usage tasks, underscoring
the necessity of action-level reward feedback. Overall, the
three modules provide complementary benefits, enabling
robust agent performance.

Impact of Instructional Video. In Table 6, we study the
impact of removing the instructional video (subtitles) by
modifying the prompt to include only the user query for
generating the initial plan. In the Excel applications, we
observe a significant performance decline, as their tasks are
complex and difficult, and rely more heavily on additional
domain knowledge for successful planning. In contrast,
the agents performs relatively well on Win. Usage tasks,
such as Settings and File Management, are where it has
more inherent pretrained prior. These findings underscore
the necessity of instructional videos for complex tasks like
visual effect design, mirroring how users learning to build
a slide often rely on tutorial videos. It is note that it is a
setup proposed in our benchmark; one can also use our data
without instructional videos.

6.3. Results by Augmentation Type

Across the 500 augmented tasks, WorldGUI-Agent (GPT-
5.1) solves 205 cases. As shown in Table 8, Add-step tasks
are the most challenging (34.1% SR), since inserted steps
create larger state mismatches. Adjust-step tasks show mod-
erate difficulty (43.1%), reflecting the need for fine-grained
manipulations. Trim-step tasks are relatively easier (52.1%),
as removing redundant steps keeps the interface closer to
the meta configuration. These trends highlight how different
forms of task-progress variation distinctively impact agent
robustness.

6.4. Failure Analysis and Robustness Dimensions

To better understand the limitations of current GUI agents
under the dynamic initial states of WorldGUI, we analyze
representative failure modes drawn from our qualitative
study (Appendix I). We observe three major robustness
dimensions that frequently lead to failures.

(1) State-mismatch robustness. When pre-actions intro-
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Table 9. Experimental results on WindowsAgentArena. The reported results are from the (Bonatti et al., 2024) and (Agashe et al., 2025b).

Method Office  Web Win. System Coding Media Win. Utils Overall
Phi3-V (Bonatti et al., 2024) 0.0 6.9 8.3 0.0 6.2 0.0 35
GPT-40-mini (Bonatti et al., 2024) 0.0 14.9 8.3 0.0 0.0 0.0 42
GPT-40 (Bonatti et al., 2024) 0.0 13.7 29.2 0.0 10.3 0.0 8.6
NAVI (Bonatti et al., 2024) 0.0 27.3 333 27.3 30.3 8.3 19.5
Agent S (Agashe et al., 2025a) w/ GPT-40 0.0 13.3 45.8 29.2 19.1 222 18.2
Agent S2 (Agashe et al., 2025b) w/ Claude-3.7-Sonnet 7.0 16.4 54.2 62.5 28.6 333 29.8
WorldGUI-Agent w/ Claude-3.5-Sonnet 7.0 533 45.8 333 28.6 333 31.2

duce interface configurations different from the default view
(e.g., an expanded settings dropdown or partially filled input
fields), agents often misinterpret the visible state or fail to
recognize that previous steps have already been executed.
As illustrated in Figure 24 (left), once a submenu overlays
other elements, the agent struggles to recover the intended
target (e.g., the “System” button), leading to incorrect plan
continuation or premature termination.

(2) Fine-grained manipulation robustness. Tasks requir-
ing precise adjustments—such as dragging sliders or manip-
ulating bars to reach a specific value—remain challenging.
Even when grounding is correct, the agent may overshoot,
undershoot, or repeatedly click without achieving the re-
quired adjustment, as shown in Figure 24 (right). This
reflects a broader difficulty in performing continuous or
multi-step manipulations that depend on spatial granularity.

(3) Ambiguous-visual-context robustness. In the absence
of clear text cues, agents exhibit uncertainty in selecting
visually similar elements. Figure 25 (left) illustrates a case
where the model must choose a centered icon from a sym-
metric layout, yet struggles due to limited visual discrimina-
tion without textual anchors. Similarly, when multiple text
elements appear close together, GUI parsers may surface
misleading anchors (e.g., the label “Replace with”), caus-
ing the agent to click an irrelevant surface-level text region
rather than the actual input box (Figure 25, right).

Overall, these failure modes echo our quantitative findings:
while grounding on static interfaces is often strong, robust-
ness to state changes, fine-grained manipulations, and text-
sparse visual contexts remains limited. These observations
highlight the need for future progress in both perception
and planning components, particularly under the multi-start,
dynamically perturbed conditions introduced by WorldGUI.

6.5. Computational Costs Analysis

We select two SoTA non-training agent frameworks Agent-S
(Agashe et al., 2025a) and Agent-S2 (Agashe et al., 2025b)
for comparing the computational costs. Take a Windows
setting task as an example, we tested on the same desk-
top PC with an AMD Ryzen 7 5800H CPU. As shown in
Table 7, our WorldGUI-Agent shows a competitive run-
ning time of 129.55s, as compared with Agent-S (131.98s)
and Agent-S2 (108.64s). The main computational costs of

our designed modules are largely affected by calling base
model. Since the main problem of desktop GUI automation
is still the suboptimal performance as shown in Table 4,
such computational costs are currently acceptable. There re-
mains a clear tradeoff between performance and time costs
in GUI automation, and this challenge is shared across the
community.

6.6. Results on WindowsAgentArena

Settings. The official WindowsAgentArena (WAA) evalua-
tion runs inside a Linux-based VM using a pre-built image
and a JSON configuration file. Since the essential logic of
WAA lies in its JSON specification of the environment state
and task instruction, we reconstruct the same environment
on a Windows machine by following the provided config-
uration (e.g., opening specified tabs or launching required
applications). We then use the instruction field from the
JSON file as the prompt for our WorldGUI-Agent, which
executes the corresponding GUI actions on Windows. Af-
ter completion, we follow WAA'’s evaluation protocol to
determine task success. When an official evaluation script
is available, we apply it directly; otherwise, we perform
manual judgment based on the given instructions. We do
not optimize the prompts, just apply our agent directly on
its tasks. Main results. Table 9 compares WorldGUI-Agent
against six agents on the WAA benchmark. WorldGUI-
Agent achieves a 31.2% overall SR surpass two SOTA api-
calling agents, Agent-S and Agent-S2, even with a weaker
base mode,]l Claude-3.5-Sonnet. These results underscore
the effectiveness of our designed critical modules.

Conclusion

We introduced WorldGUI, a benchmark that evaluates GUI
agents under diverse, dynamically perturbed initial states,
an aspect largely absent from existing evaluations. By con-
structing task-progress variations via pre-actions, WorldGUI
enables systematic assessment of robustness and recovery
in realistic GUI scenarios. We also presented WorldGUI-
Agent, a lightweight, universal framework that inserts three
verification stages into the standard planning loop to im-
prove stability in dynamic environments. Our experiments
show that current agents, including strong commercial mod-
els, still struggle under non-default states, while WorldGUI-
Agent offers consistent gains.
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Impact Statement

This paper introduces a benchmark and agent framework
intended to advance research on dynamic GUI automation.
Our goal is to improve the evaluation and reliability of GUI
agents in controlled environments, which may support future
progress in productivity tools, accessibility assistance, and
educational software. As with many advances in machine
learning and automation, there are potential risks, including
misuse of automated GUI agents for large-scale or unautho-
rized interactions with software systems. Our benchmark
does not involve personal or sensitive data and is designed
strictly for research use. We encourage practitioners to in-
corporate appropriate safeguards, such as permission checks,
sandboxing, and oversight, when deploying GUI agents in
real-world applications. Overall, we believe the broader
societal impacts of this work align with those commonly
associated with progress in machine learning, and we do not
identify specific concerns beyond these general considera-
tions.
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A. Task Formulation

GUI Automation. Following prior work (Xie et al., 2024;
Zhou et al.), we model GUI automation as a partially observ-
able Markov decision process (POMDP) (S,0, A, T, R).
Given a natural-language query ¢ and optional instructional
video v, the agent receives an observation o; of the current
state s; and outputs an action a; € A, which updates the
environment to sy 1. The episode terminates when the task
succeeds or fails, and R returns a binary completion signal.

WorldGUI Tasks. As illustrated in Figure 1, each task in
WorldGUI is instantiated under multiple initial states that
all converge to the same goal. We create these variants
through pre-actions—short executable sequences that shift
task progress without altering the UI skin, resolution, or
layout. This design enables controlled task-progress pertur-
bations (Add/Trim/Adjust-step) and complements existing
online GUI benchmarks; key differences are summarized in
Table 1.

Observation Space. The agent observes (i) application
metadata m; (e.g., panel structure and parsed Ul elements),
and (ii) a screenshot V; of the current GUI state, following
(Gao et al., 2024). Metadata provides structured grounding
anchors, while screenshots offer holistic visual context for
planning and action generation.

Action Space. Actions include raw mouse and keyboard
operations (click, drag, type, shortcuts), with mouse actions
parameterized by pixel coordinates in V;. We use PyAuto-
GUT* for execution, and represent each action in the form
action_type (arguments) (Table 10).

Table 10. The action types and examples.

Action Type ‘ Example

Mouse Movement moveTo (120, 200)

Mouse Clicks click (200, 300)
Keyboard Type write (’classes’)

Hotkey hotkey (' ctrl’, ’'a’)
Scrolling scroll (-100)

Drag dragTo (120, 220, 2)
Mouse Down and Up | mouseDown () ; mouseUp ()
Press Keys press ('delete’)

Key Down and Up keyDown (’ shift’)

B. WorldGUI-Agent: Thinking before Doing

In this section, we introduce an universal GUI framework
WorldGUI-Agent with a core and essential designing prin-
ciple: critical thinking, which is vital for designing GUI
agents capable of handling dynamic environments that have
been overlooked in prior GUI agents (Hong et al., 2024;
Cheng et al., 2024; Lin et al., 2024; Zhang et al., 2023;
Agashe et al., 2025a). The WorldGUI-Agent includes the
five fundamental but essential components as in Figure 6

4https ://pyautogui.readthedocs.io
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and an Interaction reasoning loop detailed in Algorithm 1.
We summarize our critical designs in the following:

e Post-Planning Critique: After the planning phase, a
critique module verifies and, if necessary, self-corrects the
generated plans to ensure their accuracy.

o Pre-Action Validation: Before executing each subtask, a
validation module determines whether the subtask should
be executed. This step is crucial, as the current GUI en-
vironment may indicate that the subtask is unnecessary or
requires modification to align with the current state.

e Post-Action Evaluation: After each action execution, a
mechanism evaluates whether the action was successfully
completed before proceeding to the next subtask.

These critique designs ensure the reliability and adaptability
of WorldGUI-Agent in complex GUI environments.

B.1. State-Aware Planner

The State-Aware Planner processes the instructional video v
and the user query ¢ generates an initial plan as shown in the
left of Figure 7. We use the speech recognition model Whis-
per (Radford et al., 2023) to translate the video v into the
subtitle and then send it to the MLLM for task planning. The
task plan is hierarchically structured as p = [p1, p2, ..., DN
where p; is a text string describing the ¢-th milestone of the
task. Under each p;, there is a list of subtasks [S], S%, S,
where S; is the j-th subtask in the ¢-th milestone. To ensure
the produced plans fit the GUI environment, we propose
incorporating an initial screenshot Vj to represent the cur-
rent state. This additional context allows the agent to output
plans that align with the actual state. For example, if the in-
structional video suggests clicking on the “Layout” tab in the
Word application, but the current state (as indicated by the
screenshot) shows that the “Layout” tab is already selected,
there is no need to perform this action again. By utilizing
the visual information from the screenshot, the State-Aware
Planner can modify the plans accordingly, rather than strictly
following the guidance in the instructional video or the ex-
isting knowledge from backbone MLLMs. It also avoids the
occlusion issue when not seeing the screenshot.

B.2. Planner-Critic

Post-Planning Critique. The goal of the Planner-Critic is
to assess the correctness of the initial plans generated by
the State-Aware Planner and provide corrections if needed.
This module is designed to ensure the accuracy of the plans
while leveraging the self-reflection capabilities of MLLMs.
As illustrated in Figure 7, for each Initial Plan, the output
consists of four components:

(1) <Flag>: Indicates whether the Initial Plan is correct.

(2) <Feedback>: Identifies the error type, categorized
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1. Planner

rd

Generate the plans based on current state

Task 1: Adjust text wrapping around a Word table
Subtask 1: Click within the table to select it.

Subtask 2: Click on the 'Layout' tab in the toolbar.
Subtask 3: Click 'Properties' from the options available.

2. Planner-Critic
Assess the correctness of plans generated
by Planner

Desktop Environment

Observe

a O

{ User Query + Instructional Video

Observe

5. Actor-Critic
Assess the success of the last action
If wrong, correct the action

Act
Feedback

3. Step-Check
Check the task completion and redundancy

Subtask 1: Click on the 'Table Layout' tab in the
toolbar.

4. Actor
Generate action represented by code
Correct the action with critic feedback

Figure 6. WorldGUI-Agent. The Planner module receives the user query and an instructional video as input and generates an initial plan.
This plan is then refined and executed step by step. Before each step is passed to the Actor module, it undergoes a Step-Check. After the
Actor produces an action, the Actor-Critic module iteratively verifies the completion of the action and makes corrections.

User Query: Make the text around the table Initial Plan
Task 1: Adjust text wrapping around a Word table
Subtask 1: Click within the table to select it.

—p Subtask 2: Click on the "Layout' tab in the toolbar.
Subtask 3: Click 'Properties' from the options
available.

Subtask 4: In the 'Table Properties' dialog, go to the
"Table' tab.

Subtask 5:

Subtask 6: Confirm the changes to apply the text
wrapping around the table.

l

State-Aware
Planner

A

—

[
Instructional Video

Initial Screenshot
Corrected Plan

Task 1: Adjust text wrapping around a Word table

Subtask 1: Click on the "Table Layout' tab in the toolbar. ——
Subtask 2: Click within the table to select it. Planner

Subtask 3: Click 'Properties' from the options available, e -+ m
Subtask 4: In the 'Table Properties' dialog, go to the Critic -

'Table' tab.

Subtask 5: Click ‘Around’ under "Text Wrapping'.
Subtask 6: Confirm the changes to apply text wrapping
around the table.

Instructional Video

You need to verify whether the provided plans can fulfill the user query. If not, please revise the
plans.

<Flag>: should be set to either true or false. If the plans are correct, selecting true, else selecting
false.

<Feedback>: If the plan is correct, please explain why. If the plan is incorrect selecting one of the
following error types: 'Wrong steps', 'Missing steps’, or '‘Redundant steps'.

<Correction>: If the plans are correct or the task is finished, output ‘None', else output the
corrected plans.

<Reason>: Please give your reasons.

Figure 7. State-Aware Planner and Planner-Critic. The Planner
generates an initial plan. Then, the Planner-Critic provides neces-
sary corrections.

into one of three options: “Wrong Steps,” “Missing Steps,”
or “Redundant Steps.”

(3) <Correction>: Provide the corrected plans if the
Flag indicates that the Initial Plan is incorrect.

(4) <Reason>: In addition to giving the corrected plans,
we force the model to give the reasons. As previous studies
(e.g., CoT (Wei et al., 2022), Deepseek-R1 (DeepSeek-Al
et al., 2025)) demonstrate that generating reasoning steps
along with the answer would enhance the performance.

B.3. Step-Check

Pre-Action Validation. After the plan assessment, a nav-
igation mechanism is crucial before sending each subtask
Sy = S; at the time step ¢ to the Actor module. To address
this, we designed a new module called Step-Check. Through
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1. Check the Step Completion.

You need to verify, based on the screenshot, whether the current task has been
completed or requires modification.
The output should be one of the following states.
<Modify>: If require modification, please either add more plans or modify current step.
<Pass>: If you think current task is unnecessary.
<Continue>: No change
<Finished>: Already Finished.
If you think current screenshot is not give all information to check the current task
completion, please output ‘#Cannot confirm'.

v

Current Task: Subtask 1: Click on MLLM #Cannot confirm

the 'Table Layout' tab in the toolbar.
Retry _.--~""" i
A ______
R P
: Crop
-

Region
Search

New Screenshot Current Screenshot

2. Subtask Navigation If #Cannot confirm

&>

Invoke Region Search
Retry

If <Modify> or <Continue>

o

Execute current subtask,
go to next module (Actor)

If <Pass> or <Finished>

Go to next Subtask

Next Subtask

Figure 8. Step-Check. This module first checks the step comple-
tion status via an MLLM and then navigates to the current task
processing.

extensive investigation, we discovered that during GUI task
testing, perfect execution plans are rarely feasible due to
the unpredictable nature of real application environments.
Most software retains user preferences (e.g., remember the
last configuration of user), meaning that when executing a
specific task, the plan p generated by the Planner might not
align with the actual state of the software. Therefore, the
model must determine whether to proceed with a subtask S;
based on the current state (screenshot: V;, metadata: M;).

As illustrated in Figure 8, we employ an MLLM to de-
termine whether the current task has been completed or
requires modification. We systematically categorize the
possible outcomes into:

(1) <Modi fy>: Indicates that the subtask should be modi-
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fied or additional subtasks should be added.

(2) <Pass>: Indicates that the current subtask is unneces-
sary and can be skipped.

(3) <Continue>: Indicates that the subtask is valid and
should be executed as planned.

(4) <Finished>: Indicates that the subtask has already
been completed and requires no further action.

In cases where the screenshot does not provide sufficient
visual information for the MLLM to determine the output,
the model outputs “#Cannot confirm”. When this occurs,
we design a Region Search module implemented by an
LLM. This module takes the corresponding GUI informa-
tion extracted by the GUI parser and the task description of
the current subtask to identify the relevant region. It then
crops the region using the generated bounding box as the
center coordinate, with the maximum width and height set
to half of the original screenshot dimensions (ensure the
region is smaller than the original screenshot). The cropped
screenshot is subsequently sent to the Step-Check module
to regenerate the decision.

B.4. Actor

The goal of the Actor is to translate natural language subtask
S; into executable code C;. Using an MLLM as the back-
bone model, the Actor processes metadata m; and screen-
shot V; as GUI context to generate precise executable ac-
tions, suchas c1ick (100, 200). Additionally, it lever-
ages the history of previous actions as memory to aid in
generating subsequent actions. The generated actions will
be executed in the environment, and then the new screen-
shot V., and metadata m;; will be captured for the next
processing.

B.5. Actor-Critic

Post-Action Evaluation. After generating an action, the
Actor-Critic module evaluates subtask S;_; completion and
makes corrections if necessary. As illustrated in Figure 9, in
the first step, the module implemented by an MLLM com-
pares screenshots V;_; (before action execution) and V; (af-
ter execution) while processing each subtask S; to determine
the action correctness. The model outputs a <Success>
flag to indicate task completion. If the <Success> flag is
true, the current state s; = <Next>. If the <Success>
flag is false (set s; = <Critic>) and the number of trial
steps is below the maximum limit, the Actor-Critic module
activates the Locate GUI Elements and Actor Correction
processes. We introduce the module Locate GUI Elements
to identify the relevant GUI elements and regenerate actions
using the Actor Correction module. The corrected actions
are then executed in the environment, generating updated
observations (O;) that include new screenshots and meta-
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Step1: Verify the Action

Based on the screenshots before and after the action, task description, software
name, please check the task completion status.

Current Task: <Subtask St-1>

Screenshots: <Screenshot Vt-1> <Screenshot Vt>

Output:

<Success> bool (Current task completion status) </Success>

<Reason> str (Analysis of possible mistakes if action is wrong) </Reason>

Current Task: Subtask 3: Click v

"Properties' from the options . MLLM = —
available.

<Success>

Step2: Iteratively Action Correction

——» If <Success> and t < max trials
is false,

State =<Critic> /\

o
v

Locate GUI
Elements

is true,
State =<Next>

Next Subtask
Actor-Critic

* Properties... [161, 127];

Act&Observe Actor

Correction

\

Click(161, 127)

Figure 9. Actor-Critic. This module includes two parts: task
verification and task correction. The design follows the verify-then-
correct mechanism.

data for the continued Actor-Critic iteration. The process
repeats until the <Success> flag is true or the maximum
number of trials is reached.

C. Additional Experiments

As shown in Table 11, Agent-S2 (Agashe et al., 2025b)
shows competitive results as compared with our WorldGUI-
Agent. We also test on two representative office software
to compare the effectiveness of our proposed agentic frame-
work by replacing the base model with UI-TARS-1.5 (Qin
et al., 2025) in Table 12. It is noted that to improve the
performance of UI-TARS-1.5, we use the GPT-4o to task
planning, as we found that UI-TARS struggles with under-
standing complex desktop software layout and cannot cap-
ture the dynamic initial condition changes. We use GPT-40
for better implementation.

D. Data
D.1. Annotators

In this work, we have four annotators: A, B, C, and D.
The team comprises one PhD student, one Master’s stu-
dent, and two undergraduate students. Prior to annotation,
all annotators receive training on using the applications in
WorldGUI to ensure high-quality annotations. For the 10
desktop applications, we divide the software into four parts,
assigning each part to a different annotator. For the human
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Table 11. Performance comparison between WorldGUI-Agent (with Claude-3.5-Sonnet and Claude-Sonnet-4) and Agent-S2 (Claude-
Sonnet-4). Results are reported across five representative applications.

Method PPT VSCode Acrobat VLC File Explorer
Meta Aug. ‘ Meta Aug. ‘ Meta Aug. ‘ Meta Aug. ‘ Meta  Aug.
Agent-S2 w/ Claude-Sonnet-4 455 189 | 455 37.8 | 182 145 | 200 163 | 60.0 64.7
WorldGUI-Agent w/ Claude-3.5-Sonnet | 54.5 39.6 | 545 267 | 63.6 20.0 | 500 184 | 500 17.6
WorldGUI-Agent w/ Claude-Sonnet-4 63.6 528 | 545 289 | 545 309 | 400 286 | 700 265

Table 12. Performance comparison between WorldGUI-Agent (with UI-TARS-1.5) and UI-TARS-1.5.

PPT Acrobat
Method Meta Aug. ‘ Meta Aug.
WorldGUI-Agent w/ UI-TARS-1.5 | 36.6 189 | 364 9.1
UI-TARS-1.5 273 17.0 | 9.1 1.8

tests presented in Table 4, the annotators demonstrate tasks
on software that they did not annotate. As shown in Table 1,
each annotator is responsible for different software during
both the annotation and human testing phases to make the
soundness of the Human Test results.

D.2. Creating Augmented Tasks

In our study, to simulate dynamic testing processing in real
GUI interactions, we propose to design GUI tasks with
various initial tasks. Specifically, we propose pre-actions
before executing the task. The pre-actions primarily serve
two purposes: 1) Simulating Intermediate Task States:
Pre-actions can complete specific steps of a task, creating
a starting point from an intermediate state. This approach
addresses scenarios where users may seek Al assistance
because they are unable to complete a task. For example, if
the task involves opening a dropdown menu, the pre-action
may pre-open the menu. If the agent fails to recognize this
precondition and follows its plan to click the menu again, it
might inadvertently close the menu, causing task failure.

D.3. Introducing Diverse Initial Context States

Pre-actions can also introduce variations in the initial state,
such as opening random tabs or settings. This ensures that
the starting state is unconventional, challenging the agent
to adapt by modifying its plan or adding new steps. We
illustrate one example in Figure 5. Here, the meta task and
augmented task, have the same user query and instructional
video and it will ideally have the same final state. We
additionally provide more examples about augmenting the
meta task in Figure 11.

E. Detailed Experimental Results

Table 14 shows the detailed results of WorldGUI-Agent
across individual applications in WindowsAgentArena (Bon-
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atti et al., 2024) benchmark. The results of this related
Windows-centric interactive GUI benchmark indicate that
current the desktop GUI tasks are more challenging than
web tasks. As we complete 11 out of 17 tasks in Web
Browsing, a similar phenomenon is also discovered in Table
4.

F. Computational Costs Discussion

The average number of execution steps and tokens con-
sumed are shown below Table 15. The execution steps are
calculated based on our experimental log files, while the
token costs are sampled from representative tasks in each
category by taking Actor module as an example.

Take a Windows Setting task as an example, we provide
detailed time costs across different modules tested on a desk-
top PC with AMD Ryzen 7 5800H CPU. Task length: 6
(generated by Planner+Planner-Critic). To facilitate a fair
comparison, we additionally selected two of the latest SOTA
agents, Agent-S (2024-10-08) and Agent-S2 (2025-04-01),
and measured their run times on the same successful task
under identical hardware and the same base MLLM (Claude-
Sonnet-4). The results are shown in Tables 16, 17, 18. To
summarize, our WorldGUI-Agent shows a competitive run-
ning time of 129.55s, as compared with Agent-S (131.98s)
and Agent-S2 (108.64s). The main computational costs of
our designed modules are largely affected by the underly-
ing large multimodal model, leaving room for acceleration
optimization.

Since desktop GUI automation is still in its early stages,
such computational costs are currently unavoidable. For
reference, even OpenAl’s Deep Research reportedly takes
over 10 minutes in daily usage. According to OpenAl Oper-
ator’s report, achieving 38.1% on OS-World requires over
100 steps, which is similarly costly. In summary, there re-
mains a clear tradeoff between performance and time costs
in GUI automation, and this challenge is shared across the
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Table 13. The annotation arrangement during the annotation and human testing phases by different annotators.

Annotators Annotation Phase Human Test Phase
A PowerPoint, Word, Excel VSCode, VLC Player, Web
B Adobe Acrobat, VLC Player Excel, Settings
C Settings, Web PowerPoint, File Explorer, Youtube
D VSCode, File Explorer Word, Adobe Acrobat

Inst. Video Preparation: Human

checks to cut the Video Clips (30s to
maximum of 3 mins) as Inst. Video.

(@
o
Q
[

02

01 03

Raw Video Collection:

Find potential Computer Use Full
Videos from Youtube (PPT, Word, Excel)
or official software website.

a

Project File Preparation:
Create the Project File for each
task. It ensures the reproducibility.

User Query Generation: gg
Manually write a User Query
for each instructional video.

A B =

Pre-actions Generation:

a

Augment each task and
generate Pre-actions.

04 06

05

(@
- @
Use the Agent to generate Initial Plans

GT-Plan Generation:

and then ask the annotators to verify and
correct the error plans.

Figure 10. Pipeline of Data Construction. Human: Represents the annotators. Code: Refers to the scripts (e.g., Python Code) utilized to
achieve the goal. Agent: We design an agent built upon the MLLMs to achieve the goal.

community.

G. Examples of Augmentations

In this section, we present several augmentation examples
in Figures 12, 13, 14, 15, 16, 17, 18. It is noted that our
augmentations are not only making the first step changing
but also require the agent add new step in its second step.
For instance, in Figure 12, our augmentation is about click
on Data tab in the ribbon, in the default software state, the
Merge & Center button exhibit in the Home tab, there is
no need to click on Home tab, after our augmentations, the
agent should add a new task “Click on Home Tab” before
it click on the Merge & Center button. Similarly, in Figure
17, the text editing buttons are under the Home Tab, if we
augment the initial state with other Tab like Animation Tab,
after the first step “Select the text "'US SUBMARINE DAY’
”, the agent should add a new step like “Click on Home
Tab” back to the default state for task execution. Except
for adding new steps, we also present an example about
adjust the step in Figure 13, as the target is about merging
cells Al to K1, we augment the initial state by selecting
A2 to K2. Such a slight difference may mislead the agent
to perceive such a minor difference, and the agent may
jump the first step about selecting the correct cells lead
to finally unsucess. In Figure 14 and Figure 18, we show
two examples of introducing pop-up window in the initial
state which require the agents accurately identify the pop-up
windows and correctly close it by replanning the task based
on the visual screenshot not only strictly planning based on
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inherited knowledge or the instructinal videos. In Figure 15,
we show an example of changing the interface by clicking
the Data tab to hide the Merge & Center button under the
Home tab. In Figure 16, we complete the first step about
selecting A1 to K1, which requires the agent to jump this
step to reduce the time costs.

H. WorldGUI-Agent Reasoning Loop
Algorithm

In this section, we provide the details of our reasoning loop
algorithm in Algorithm 1.

I. Qualitative Results

(1) In Figure 19, we present a successful prediction example,
demonstrating that the WorldGUI can effectively plan each
step for a task, accurately perceive specific elements in the
GUI, and convert them into the correct action code. Addi-
tionally, we display the parsed GUI elements, which can
accurately identify most content, including small icons and
dense text elements. (2) We provide the visualization results
of using Planner-Critic, Step-Check, and Actor-Critic in Fig-
ure 21, Figure 22, and Figure 23. These qualitative results
demonstrate the effectiveness of these critical modules in
GUI automation. (3) We also highlight some common er-
rors encountered. 1) The model has difficulty obtaining the
desired information when we augment the task by invoking
the dropdown menu of the Settings application. As shown
on the left of Figure 24, when we click on the ’System’
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Query 1: Add a note to the second ppt, the content of the note is 123

Meta

L US SUBMARINE L K US SUBMARINE
= DAY , =

Here 5 whero yourpresentation begns
—

Pre-actions: None Pre-actions: Click on slide 3. Pre-actions: Click on the “Replace” button in the
It may mislead the planner to omit adding the Home ribbon.
step ‘click on slide 2' because of the concept of It augments the context of performing the task.
slide 1, 2, 3 is not easy to obtain only from The agent should understand the current state
screenshot. and then close the pop-up window to continue

the process.

Query 2: Make the text around the table

Pre-actions: None Pre-actions: Click on “Design” Tab. Pre-actions: Click on “Table Layout” to stimulate
It make the context changed. The agent should the intermediate initial state.
not mislead by current state.

Figure 11. We present the examples of conducting the augmentations from the meta task.

button on the left, it is challenging for our model to extract
the button’s position as it is hidden. Such cases require the
model to have a higher level of ability to delete the content
in the input box or click on the blank area. 2) As shown
in the right of Figure 24, the model has difficulty dragging
a bar to achieve the desired value. 3) The model struggles
with the visual choice when there is no text information
in the screenshot, as shown on the left of Figure 25. The
subtask aims to select the center button, but the current
model makes it hard to detect the center choice only from
the screenshot. 4) The model cannot successfully locate
the position of the input box, as the GUI parser will easily
locate the text location 'Replace with’, it always outputs
the action like clicking on the ’Replace with’, which will
destroy the whole task’s success.
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Table 14. Detailed experimental results of WorldGUI-Agent across individual applications in WindowsAgentArena (Bonatti et al., 2024).

Domain Application #Tasks #Successes SR (%)
Web Browsing chrome 17 11 64.71
Windows Utilities  clock 4 2 50.00
Windows System  file_explorer 19 7 36.84
Office libreoffice_calc 24 1 4.17
Office libreoffice_writer 19 2 10.53
Windows Utilities  microsoft_paint 3 1 33.33
Web Browsing msedge 13 5 38.46
Windows Utilities notepad 2 1 50.00
Windows System  settings 5 4 80.00
Media & Video vlc 21 6 28.57
Coding vs_code 24 8 33.33
Windows Utilities ~windows_calc 3 0 0.00
Overall 154 48 31.17

Table 15. Average execution steps and token costs on different software.

Application category ~ Average execution steps  Input tokens per step (Actor) per task ~ Output tokens per step (Actor) per task

Office ~23 2350 212
Win. Usage ~20 1929 108
Web ~17 1637 84

Table 16. Running time with WorldGUI-Agent (ours).

Subtask Index Executed Modules Time (seconds)
0 Planner 4.48
0 Planner-Critic 11.47
1 Parser 2.03
1 Step-Check 4.95
1 Actor 7.47
1 Parser 2.07
1 Actor-Critic 7.38
2 Parser 2.03
2 Step-Check 6.71
2 Actor 6.05
2 Parser 2.07
2 Actor-Critic 7.97
3 Parser 2.12
3 Step-Check 6.35
3 Actor 6.71
3 Parser 2.22
3 Actor-Critic 10.06
4 Parser 2.01
4 Step-Check 6.19
4 Actor 8.54
4 Parser 2.40
4 Actor-Critic 9.55
5 Parser 2.22
5 Step-Check 6.50
Total - 129.55
Average (per action) - 22.72
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Table 17. Running time with Agent-S.

Step Executed Modules Time (seconds)
0 Manager 2.02
1 Manager 10.11
2 Worker 16.05
3 Worker 12.38
4 Worker 17.30
5 ‘Worker 12.26
6 Worker 15.17
7 Worker 15.46
8 Worker 11.83
9 Worker 19.40
Total - 131.98
Average (per worker) - 14.98

Table 18. Running time with Agent-S2.

Step Executed Modules Time (seconds)
0 Manager 11.87
1 Worker 7.27
2 Worker 13.21
3 Worker 13.59
4 Worker 14.04
5 Manager 10.61
6 Worker 9.87
7 Manager 7.53
8 Worker 20.65
Total - 108.64
Average (per worker) - 13.22
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User Query: Merge A1:K1

projectxis - Excel

=] & proj Excel

File Home Insert Pagelayout Formu as m ew View Help Acobat PDFelement ) Tell me what you want tof

™ s} = &C
’Gmml—v‘ Fl:l 3 D‘J ’“‘ D " . heries & Connections | o) ‘E Y E‘%
Get esh

Pagelayout Formulas Data Review View Help Acobat PDFelement  Q Tell me whatyou want t

= 1 From  From From Table/ Recent Existing Rel z| Sort Filter Textto
Feste B IUv|[H|&-A|F- $v% * R B C Daaviewcsy weo Range Sources Comections | AN & Y Advanced | Columns
e ot . Nomber o Get & Trantorm Data Queries & Connectons Sort & Fiter
i . £ e Al - Jr | timestamp

A 8 c D E 3 G H i ) K
£ D L G 5 Ll 1. 1 [imestam I inearimu inearl " entImu0_orientImu_orieniimu0_orien]ati

1 [timestamp [Imu0_linearimu angul orienlat , Tgiorr08 25 162 P07| 0.0344505| -0.314152| -0.936193
2 [ 1676E+09 25 162 9.17 0 0.04 001 -0126207 00944605 -0314152 0936193 3 1g7ep+09 245 163 fiaa 0.053865] 0.324841 0936250
3 | L676E+09 340093865 -0314841 0936259 41 6766+09 252 161 336 00959795 -0315462 -0.935762
4 | L676E+09 36 00959795 -0315462 -0.935782 5  1676E+09 249 155 b59 00970312 -0.316984 -0.935456
5 | L676E+09 M & C 39 00970312 -0316984 -0935456 g | 1676E+09 253 158 383 00979687 -0317809 -0935171
6 | 1676E+09 erge enter ™ 35 oosresEr 030 -0s3B1TI 7 | 1676E+09 248 161 ) Querig, oossazer oarmes -osssia
7 | L6T6E+09 32 00954241 -0317745 -093514 g | 1676E+09 251 16 & 598 00964569 -0.318285 -0.934927
8 | L6T6E+09 )8 00964569 -0.318285 -0934927 9 | L6T6E+09 251 161 . 511 00983317 -0.318693 -0.934472
9 | 1676E+09 251 161 912 01 0.02 0 -0.124611 00983317 -0.318693 -0934472 10 1676E+09 255 161 Existing Refresh 754 01000898 -0.319251 -0.934076
10| 1676E+09 255 161 9.13 009 004 0 -0.124754 01000898 -0319251 -0934076 11| 1676E+09 251 184 Connections Al v 701 00968652 -0.319348 -0.934255
11| 1676E+09 251 164 9.14 01 005 001 -0125701 00968652 -0319343 -0934255 12| 1676E+09 256 155 195 00977742 0319997  -0.93406
12| 1676E+09 256 155 916 01 004 0 -0124795 00977742 -0319997 -093406 13 1676E+09 249 159 Queries & p38 00964959 -0320392 -0.934212
13| 1676E+09 249 159 917 01 003 0 -0123638 00964959 -0320392 -0934212 14 1676E+09 251 16 a7 01 004 0] -0122674) 0077396, -0.321055| -0.833942
14| 1L676E+09 251 16 9.17 01 004 0 -0.122974 00977396 -0.321055 -0933042 15/ 1676E+09 25 156 923 008 004 01 -0.121375| 0.0064479| -0.321554] -0.934114)

Default State Augmented State

GT Plan:

Task 1: Select A1:K1

Subtask 1: Select the cells Al through K1.

Task 2: Merge cells

Subtask 1: Click the Merge & Center command.
Subtask 2: Click 'OK' to confirm the change.

Figure 12. Augmented example of an Excel Task.

User Query: Merge A1:K1

proje = projectxisx - Excel
W Help rob: PDFelement ~ Q Tell me what you w Insert  Pagelayout Formulas Data Review View Help Acobat  PDFelement @ Tell me what you want to)
o =
X = T a A | =E= ® wepte [Genera B = hE | I ax Pe o BwapTen Genera B
B - B v
R B I U-|[H. OvAv % |===&% EMegetcenter + | $ v % > |8 3 gg:;:‘";[' R B I U~ [Hv[dvAv %y | === 8% EMegeacener + | §+% 0 RO
Clipboard Font Ll Alignment Ll Number Ll s Clipboard 15| font [ Alignment. [ Number [
AL M Je | timestamp A2 - Jr | 1676011543
A 8 c D 3 3 G H 1 J K L c D E 3 & H i ) K
1 [timestamp imup_linear Imu0_tinear Imu0_linear Imu0_angulImu0_angulImu0_angulImu0_orientImu0_orientImu0_orientImu0_orienation_w 1 [timestamp_imuff linear Imu0_linear Imu0_linear Imu0_angulImu0_angul Imu0_angul Imu0_orientimu0_orient Imu0_orientImu0_orientati
2 | 1676E+09 25 162 917 0.09 004 001 -0126207 00944605 -0.314152 -0936193 2 [L676E+09 25 162] 917 009 004 001 -0.126207 0.0944605 -0314152 -0.936103]
3 | 16766+09 245 163 917 01 004 0 -0124434 0093865 -0.314841 -0936259 3 [1676E+09 245 163 917 01 004 0 -0.124434 0093865 -0314841 -0.93625
4| 16766+09 252 161 9.16 01 003 0 -0124836 00959795 -0.315462 -0935782 2| 16766409 161 9.6 01 003 0 -0124836 00959795 -0315462 -0.935782
T TOTRET00 249 155 914 011 002 001 -012259 00970312 -0.316984 -0935456 9.4 o1 002 001 -012259 00970312 -0316984 -0.935456
6 | 1676E+09 2.53 158 005 001 -0.121883 0.0979687 -0.317809  -0.935171 6 | 1676E+09 253 011 005 001 -0.121883 00979687 -0317809 -0.935171
7 | 1676E+09 003 001 -0.124282 00954241 -0317745 -093514 7 | 1676E+09 248 011 003 001 -0.124282 00954241 -0317745 -093514
8 | 16766+09 005 0/ -0.123698 00964569 -0.318285 -0.934927 8 | 1676E+09 251 16 009 005 0 -0.123698 00964569 -0.318285 -0.934927
9 | 1676E+09 002 0] -0.124611| 00883317, -0.313693 -0.934472 9 | 1676E+09 251 161 002 0 -0124611 00983317 -0318693 -0.934472
i : timestamp_Imu0_linear |
1 [timestamp \ImuO_Ilnead\ 1 ‘m
i + :
2| 1E7EE+09 £5 ; 1676E+09 245
| : + .
3 1676E+09 245 3 oo iy
| : + 8
4 | 1676E+09 252 4

Default State Augmented State

Figure 13. Augmented example of an Excel Task.
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User Query: Merge A1:K1

Fomulas Dola Reew View Help  Acobal  PDfclement Q) Tellmewhal youvant oo Pofcerment Q. Tellmewhat
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Default State 3g Find and Replace o x

g Find  Replace
Options >>
Find All ‘ Find Next Close

Augmented State

Figure 14. Augmented example of an Excel Task.

User Query: Merge A1:K1
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Figure 15. Augmented example of an Excel Task.
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User Query: Merge A1:K1
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Figure 16. Augmented example of an Excel Task.

User Query: Set US SUBMARINE DAY in the first ppt to fontsize 40

= [E—r—

Insert  Draw  Design ons

- I I [F=] Layout ¥
0 7 Reset
Paste New B I U S
& Slide v [ Section ¥
Clipboard N Slides

Default State

D
i st

US SUBMARINE
DAY

Here is where your presentation begins

Animations  Slide

2ar

Transitions

| US SUBMARINE

: DAY

Here is where your presentation begins

projectpptx - PowerPoint

LUINENSHE  Slide Show  Record  Revig

2 2 w »
Fly In Float In Split Wi
Animation

Augmented State

Figure 17. Augmented example of a PowerPoint Task.
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User Query: Select all text and apply numbered list for them. Use '1, 2, 3' symbol of numbered list.

They re simple

You can organize your deas clearly & your ideas clearty

You'l never forget 1o buy mik! B e B0 buy mik!

They're simple Replace r x

Replace with: Close

You can organize your ideas clearly

O Match case

& your ideas clearly
O Find whole words only L

(0 Match halffull wicth forms et to buy milk!

You'll never forget to buy milk!

Default State Augmented State

Figure 18. Augmented example of a PowerPoint Task.

Subtask 1: Open the 'Settings' application on your PC.  Subtask 2: Click on 'System' in the left sidebar. Subtask 3: Click on 'Notifications' from the available options.

Q Notifications

Home Alerts from apps and system, do not disturb

System
Bluetooth & devices

Network & internet

Subtask 6: Toggle the switch next to 'Battery saver' to the

Subtask 4: Scroll down to the 'Notifications from apps  Subtask 5: Locate the 'Battery saver' item in the list. 'Off" position to disable notifications

and other senders' section.

m > Notifications Notifications

Q) Battery saver
off

©

Figure 19.

We show one successful prediction of or WorldGUI-Agent.
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Algorithm 1 WorldGUI-Agent Reasoning Loop Algorithm

Input: State s, Action Code C, Screenshot V', Metadata m, Current subtask S, Critic_count z
Generate task plan p with Planner and Planner-Critic
Initial current subtask S;—o = S7, where S is the 1-th subtask in the 1-th milestone of p.
Initial sg = <Continue>
while S; is not end and ¢ < max trials do
Observe metadata m; and Screenshot V; from Env.
Obtain state s; by running Step-Check.
if s; = <Next> then
Go to the next task S;11 = next(S)
end if
Check potential modification of subtask .S;
Obtain action code C'; by running Actor; Execute the action code C} in the Env.; Observe metadata m; and Screenshot
V; from Env.
Set C; = None; t = t + 1; Set state s, = <C'ritic> (For each subtask, the first step is finished, then execute the
actor-critic process)
Observe metadata m; and Screenshot V; from Env.
Running Actor-Critic and obtain the state s,
if s; = <Next> then
Go to the next task Sy 11 = next(S;).
end if
while s; = <C'ritic> and z < max critique trials do
Running Actor-Critic and obtain the state s, and corrected action code C}
if s; = <Next> then
Go to the next task S;11 = next(St).
end if
Execute the action code C} in the Env.; Observe metadata m; and Screenshot V; from Env.
SetCy; =None; z =2+ 1
end while
Go to the next task S;11 = next(S;)
t=t+1
end while

=] e s
==} S o Choose how you appear and what you see on YouTube|

BEBEE
npeaes

o
BBRBEREREA0EER0BEEREEE)

@
@ ) O B s

: Nais P » G = < ~oa
Figure 20. We show two examples of using GUI Parser to obtain the element position information.

o g
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Screenshot

Initial Plan

Task 1: Format the whole document into two columns
Subtask 1: Click on the Layout tab.

Subtask 2: Click the Columns command.

Subtask 3: Click on Two to format the document into two
columns. l

Planner Critic

.

<Feedback>Missing steps. The current plan does not include selecting all the text in the document before applying the column
format, which is necessary to ensure the entire document is formatted into two columns.</Feedback>

<Flag>false</Flag>

<Correction> m
Task 1: Format the whole document into two columns

Subtask 1: Click on the Home tab.

Subtask 2: Click anywhere in the text area and press Ctrl + A to select all the text in the document.

Subtask 3: Click on the Layout tab.

Subtask 4: Click the Columns command.

Subtask 5: Click on Two to format the document into two columns.

</Correction>

<Reason>The user query is to change the whole document from one column to two columns. The current plan does not include
selecting all the text in the document, which is necessary to apply the column format to the entire document. The correction
includes selecting all text before applying the column format, ensuring the entire document is affected.</Reason>

Headin «| “r

Figure 21. An example of using Planner-Ceritic to correct the plan.

Screenéhot Previous Finished Tasks: Subtask 1: Click on the text "US

SUBMARINE DAY" within the main Slide Pane to select it.

> :
Current Task: Subtask 2: Go to the "Font" group on the toolbar.
Us SUBMARI“E Next Task (for reference, you should consider whether current task is
1 D AY 1 necessary when we complete next task ): Subtask 3: Type "40" in the
font size box to set the font size to No. 40.

Here is Where your begins

<Finished>
<Reason>The "Font" group on the toolbar is already visible in the
screenshot, indicating that the current task of going to the "Font"

group has been completed.</Reason> m

Previous Finished Tasks: ...Subtask 2: Click the Insert tab in the
PowerPoint toolbar. Subtask 3: Click the Table command.

Current Task: Current Task: Subtask 4: Mouse over the grid to
select a 3x3 table.

Next Task (for reference, you should consider whether current task is
necessary when we complete next task ): Subtask 5: Click to insert
the table with the selected number of rows and columns.

NEXT YEAR

Mercury is the closest planet to the
Sun and the smallest one in the Solar
System—it's only  bitlarger than the
Moon. The planet's name has nothing
to do with the liquid metal

H Output: <Continue>

- o tm m

Figure 22. Two examples of using Step-Check to check the subtask status.

26



Submission and Formatting Instructions for ICML 2026

6 | 1.68E+09 253 15 .
7 168E+09 248 14 enshot After Action (Crop for best view)
8 | 1.68E+09 251 1
9 | 1.68E+09 251 161 9.12 01 0.02 0 -0.12461 0.098332 -0.31869 -0.93447
10 | 1.68E+09 255 161 9.13 0.09 0.04 0 -0.12475 0.10009 -0.31925 -0.93408
11 1.68E+09 251 164 9.14 01 0.05 1 -0.1257 0.096865 -0.31935 -0.93426
12 | 1.68E+09 256 155 9.16 01 0.04 0 -0.12479 0.097774 -0.32 -0.93406
13 | 1.68E+09 249 159 9.17 01 0.03 0 -0.12364 0.096496 -0.32039 -0.93421
14 | 168E+09 251 16 9.17 01 0.04 0 -0.12297 0.09774 -0.32106 -0.93394
156 9.23 0.0 0.04 0 -0.12137 0.096448 -0.32155 -0.93411
16 | 1.68E+09 253 158 9.14 01 0.04 0 -0.12536 0.099308 -0.32208 -0.93311
17  168E+09 251 159 9.22 011 0.03 0 -0.12455 0.09745 -0.32242 -0.93329
18] 1.68E+09] 254 157 9.17 0.09 0.04 0 -0.12338 0.098104 -0.32301 -0.93317
19 | 1.68E+09 252 156 9.16 01 0.03 0 -0.12209 0.097976 -0.32355 -0.93317
20 | 1.68E+09 2.52 162 9.18 0.09 0.02 1 -0.12572 0.096462 -0.32342 -0.93289
21 1.68E+09 253 158 9.14 0.08 0 0 -0.12378 0.098865 -0.32438 -0.93257

22 | 1.68E+09 248 163 9.18 011 0.02 002 -0.12519 0.095371 -0.32459 -0.93267
23 | 1.68E+09 241 165 9.17 0.09 0.04 001 -0.12535 0.09211 -0.32478 -0.93291
24 | 168E+09 251 156 9.16 011 0.06 002 -0.12496 0.093045 -0.32561 -0.93258

25 1.68E+09 252 159 9.13 0.1 0.03 002 -0.12566 0.096993 -0.3273 -0.93149

26 168E+09 25 163 9.17 008 001 001 -0.12514 0095156 -032753 -093167

27 168E+09 252 159 914 0.09 001 0 -012477 0096781 -0.32803 -0.93138

28 168E+09 246 169 9.28 0.06 001 0 -012591 0093682 -0.32784 -0.93161

29| 168E+09 244 164 9.15 0.08 0 0 -012493 0092259 -0.32807 -09318.

30| 168E+09 247 166 9.11 0,07 0 -001 -012738 0093947  -0.328 -093132
Sheet1 ®

Readly o, aceacsibiliv: Gaod to o

Based on the screenshots before and after the action, subtask description, software name Excel, please check the action completion status.
Current Task: Subtask 1: Click on cell A18 to select it
current action: from pyautogui import click\nclick(17, 675)
Parsed GUI Screenshot Info: [Note that: element format is "name [its position]", separate with comma]
Excel:
elements:
Status Bar [960, 1006]; Status Bar [960, 1006]; Status Bar [960, 1006]; Cell Mode Ready [33, 1007]; Macro Recording Not Recording [85, 1007];

Accessibility Checker Accessibility: Good to go [198, 1007]; Average 152364686.9 [1126, 1007]; ...
<Success> True </Success> m

<Reason> The action to click on cell A18 was successfully completed. The second screenshot shows that cell A18 is selected, as indicated by the
highlighted cell and the cell reference "A18" in the Name Box. </Reason>

Figure 23. An example of using Actor-Critic to correct the actions.

Query 1: Turn on Storage Sense Query 2: Set the brightness under Dynamic Lighting with 70%
Subtask: Navigate to the 'System' section. Subtask: Drag to set brightness to 70%

System e > Dynamic Lighting

windowsjlil
Add or remove programs
Windows Update settings

Windows Security settings

Language settings

Activation settings

Show all results

Accounts

Error: The dropdown menu hides the “System” button. Thus Error: The Actor cannot provide exact bbox to achieve the goal of
the GUI Parser and MLLM cannot find the “System” in this dragging to 70%.
screenshot.

Figure 24. We display some common errors.
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Query 1: Format the slide background with gradient fill Query 2: Replace all the 'Reading’ in the text with 'RA’
Subtask: Select 'Center’ Subtask: Enter 'RA' in the field behind the 'Replace with' text.

Headin «

Direction D

L [S] T

od

O Replace with:

2w oy sers. Wormers [ - Wowsny @ B B - o

Error: The Actor Model cannot identify the “center” button Error: The Actor cannot click on the input field as the parsed
in this dropdown menu bbox is the position of text “Replace with”

Figure 25. We display some common errors
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